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The ProblemTracker Installation Guide provides the details necessary to prepare for and install your 
ProblemTracker software. Information such as system requirements, license information, and 
recommendations for web server and browser settings are included in this guide. 

Additional Help Guides 

After installing ProblemTracker, you can begin to configure your workgroups (databases) with the information 
available in the Workgroup Management System Guide. 

The Administration Guide is available to help you customize each of your ProblemTracker workgroups 
(databases). 

Lastly, a User's Guide is available as a resource for your ProblemTracker users. 
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Glossary of Terms

Click on the term to read more about it within the Help section listed to the right. 

●      Enter Key - Entering License Information 

●      License Agreement - Entering License Information 

●      License Manager - Entering License Information 

●      Remove Key - Entering License Information 
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Client Requirements

●     Any platform on which Netscape version 6.2 or greater, or Microsoft Internet Explorer version 5.5 or 
greater is available.

●     Netscape version 6.2 or greater, or Microsoft Internet Explorer version 5.5 or greater.

Server Requirements

●     A 600 MHz Intel Pentium III (or compatible) system is required. An Intel Pentium 4 system (or 
compatible) is recommended. 

●     For Windows 2000 Server, a minimum of 192 MB of RAM is required and 512 MB (or more) of RAM is 
recommended. For Windows Server 2003, a minimum of 256 MB of RAM is required and 512 MB (or 
more) of RAM is recommended. For Windows NT Server 4.0, a minimum of 128 MB of RAM is required 
and 256 MB (or more) of RAM is recommended. 

●     50 MB of disk space to install ProblemTracker with one workgroup, plus approximately 20 MB of disk 
space for each additional workgroup. 

●     Windows 2000 Server, Windows Server 2003 (32-bit version), or Windows NT 4.0 Server operating 
system. Windows NT Server 4.0 can not be used if you are using the UTF-8 (Unicode) character set, 
ProblemTracker API add-on, or ProblemTracker Add Record via Email add-on. Windows NT Server 4.0 
is not recommended for use with new ProblemTracker installations as Microsoft has discontinued 
security fixes and support for Windows NT Server 4.0. 

●     Microsoft Internet Information Server 4.0, 5.0, or 6.0. IIS 5.0 or 6.0 is recommended. IIS 5.0 or 6.0 is 
required if using the UTF-8 (Unicode) character set. IIS is included in Windows NT Server 4.0 (IIS 4.0), 
Windows 2000 Server (IIS 5.0), and Windows Server 2003 (IIS 6.0). 

●     MDAC 2.5 or greater. This is included in Windows 2000 Server and Windows Server 2003. It can be 
downloaded for Windows NT Server 4.0. 

●     Microsoft JET 4.0 Service Pack 5 or greater. This is included in Windows 2000 Service Pack 2 (or 
greater) and Windows Server 2003. It can be downloaded for Windows NT Server 4.0 and pre-SP2 
versions of Windows 2000 Server. 

●     Sun Java Runtime Environment (JRE) 1.3.1 (or greater) or Microsoft Java Virtual Machine (JVM). Sun 
Java is recommended for Windows 2000 Server and Windows Server 2003. Only Microsoft Java is 
supported on Windows NT Server 4.0. 

●     Microsoft JScript 5.5 or greater is required. This is included with Internet Explorer 5.5 or greater (if IE 
5.5+ is installed on your server, you already have JScript 5.5 or greater installed). It can also be 
downloaded and installed separately. 

●     In order to integrate Source Code Control with ProblemTracker, Microsoft Visual SourceSafe Version 
6.0 Server with Service Pack 5 or greater is required. 

Details about how to verify that you have the proper components installed on your web server and where to 
download them if you do not can be found in the Preparation for Installing ProblemTracker section of this 
manual. 
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Optional Database Support

In addition to the included support for Microsoft Access, ProblemTracker can be used with the following 
database systems 

●     Microsoft SQL Server 7.0 (Standard or Enterprise Edition) 
●     Microsoft SQL Server 2000 (Standard or Enterprise Edition) 
●     Oracle Database 8i (Standard or Enterprise Edition) 
●     Oracle Database 9i (Standard or Enterprise Edition) 
●     Oracle Database 10g (Standard or Enterprise Edition) 

Details about how to verify that you have the proper database components installed (on your web server and/or 
database server) and where to download them if you do not can be found in the Preparation for Installing 
ProblemTracker section of this manual. 

For Further Information

For further information on NetResults ProblemTracker, please browse to our web site at 
www.problemtracker.com. There you can find the latest product, ordering, and support information. 
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Overview

ProblemTracker requires that a supported web server, database drivers, and (optionally) SQL Server or Oracle 
software is installed prior to running the ProblemTracker Setup (installation) program. Most or all of this 
software may already be installed. The sections below describe what is required, how to verify that the 
appropriate software is installed, and how to download and install the software, if necessary. 

Web Server Software

Microsoft Internet Information Server (IIS) version 4.0, 5.0, and 6.0 are supported for use with ProblemTracker. 
Please scroll down to the appropriate section for information on how to install the IIS web server and 
associated software on your web server machine (or verify that it has already been installed). 

IIS 6.0 (Windows Server 2003)
Microsoft Internet Information Server 6.0 is not installed by default. If it has been installed, the following item 
should be in your Start menu.
Start->Administrative Tools->Internet Information Services (IIS) Manager
 
If IIS 6.0 has not been installed, you can install it by running Add/Remove Programs from the Control Panel. 
After starting Add/Remove programs, click on the Add/Remove Windows Components box, click on the box for 
"Application Server" and click Details. Check the box for Internet Information Services (IIS), then click Details. If 
you would like to install the minimum necessary components, select Common Files, Internet Information 
Services Manager, and World Wide Web Service. Click OK twice, click Next to install the selected components, 
then click Finish to complete the operation. 

ProblemTracker uses Java to send and receive email messages (from the web server machine on which 
ProblemTracker is installed). As such, it is required that either the Sun Java Runtime Environment (JRE) 
version 1.3.1 (or greater) or Microsoft Java Virtual Machine (JVM) is installed on the ProblemTracker server. As 
Microsoft plans to discontinue support of its version of Java, Sun Java is recommended and can be 
downloaded from the Sun Java web site (click the Get It Now button on the site). 

IIS 5.0 (Windows 2000 Server)
Microsoft Internet Information Server 5.0 is probably already installed on your Windows 2000 Server machine. 
If installed, the following item should be in your start menu.
Start->Programs->Administrative Tools->Internet Services Manager
 
If IIS 5.0 is not installed, you can add it by running Add/Remove Programs in the Control Panel. After starting 
Add/Remove programs, click on the Add/Remove Windows Components box, then check Internet Information 
Services (IIS) in the wizard display that appears. If you would like to install the minimum necessary 
components, select Internet Information Services and click Details. Then select Common, Internet Information 
Services Snap-In (a tool used to configure your web server) and World Wide Web Server (the web server) and 
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click OK (you do not need "Internet Services Manager (HTML)"). Then click Next to install IIS 5.0. 

As ProblemTracker requires JScript 5.5 or greater, you may also need to install the Windows Script 5.5 (or 
greater) engine. If you have already installed Internet Explorer 5.5 (or greater) on your web server machine, 
you already have Windows Script 5.5 (or greater) installed. Otherwise, please install/upgrade to Internet 
Explorer 5.5 (or greater) or browse to the Windows Script Download page, download and install the Microsoft 
Windows Script Engine (version 5.5 or greater). 

ProblemTracker uses Java to send and receive email messages (from the web server machine on which 
ProblemTracker is installed). As such, it is required that either the Sun Java Runtime Environment (JRE) 
version 1.3.1 (or greater) or Microsoft Java Virtual Machine (JVM) is installed on the ProblemTracker server. If 
you are either currently using or have upgraded from Windows 2000 Server Service Pack 3 or earlier (and 
Internet Explorer is installed on the machine), then the Microsoft JVM is already installed. If your first installation 
of Windows 2000 Server included Service Pack 4 or if you've never installed Internet Explorer, you may not 
have the Microsoft JVM installed. On Windows 2000 you can either use the Microsoft JVM or Sun Java (JRE). 
The ProblemTracker installation program will determine which version is installed and use it (or if both are 
installed, it will allow you to select which one ProblemTracker should use). If you don't have Java installed, you 
can download Sun Java from the Sun Java web site (click the Get It Now button on the site). As Microsoft plans 
to discontinue support of its version of Java, you can no longer download the Microsoft JVM from Microsoft. 

If you are planning to use multinational workgroups (UTF-8 character set for support of languages other than 
western European), you must have the Q294831 IIS 5.0 hot fix installed. If you have installed Windows 2000 
Service Pack 3 or 4, then this hot fix is already on your server. Otherwise (if you are using SP2 or earlier), 
please browse to the IIS 5.0 UTF-8 Encode Hot Fix page, download, and install the hot fix. 

IIS 4.0 (Windows NT Server 4.0)

Note: We strongly recommend that you do not install ProblemTracker on Windows NT Server 4.0. 
Microsoft has discontinued security fixes and support for Windows NT Server 4.0. Additionally, 
ProblemTracker 6.0 will not include support for Windows NT Server 4.0 as a web server platform. 

Microsoft Internet Information Server 4.0 may already be installed on your Windows NT Server 4.0 machine. If 
installed, the following item should be in your start menu.
Start->Programs->Windows NT 4.0 Option Pack->Internet Information Server
(if using NT 4.0 Server)  

If IIS 4.0 is not installed, you can install it from the NT 4.0 Option Pack available directly from Microsoft. Please 
follow the instructions provided with the Windows NT 4.0 Option Pack to install the IIS 4.0 web server. When 
installing the Option Pack, please make sure the "Internet Service Manager" and "World Wide Web Server" 
components are installed. These components are set to install if the default installation parameters are 
accepted. After installing, please reinstall the NT 4.0 Service Pack which you are using to apply the latest IIS 
fixes to your Option Pack installation. NT 4.0 Service Pack 6a (or greater) is required for use with 
ProblemTracker. 

As ProblemTracker requires JScript 5.5 or greater, you may also need to install the Windows Script 5.5 (or 
greater) engine. If you have already installed Internet Explorer 5.5 (or greater) on your web server machine, 
you already have Windows Script 5.5 (or greater) installed. Otherwise, please install/upgrade to Internet 
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Explorer 5.5 (or greater) or browse to the Windows Script Download page, download and install the Microsoft 
Windows Script Engine (version 5.5 or greater). 

ProblemTracker uses Java to send and receive email messages (from the web server machine on which 
ProblemTracker is installed). As such, it is required that the Microsoft Java Virtual Machine (JVM) is installed on 
the ProblemTracker server (ProblemTracker does not support the use of Sun Java on Windows NT 4.0 Server). 
The Microsoft JVM is installed along with Internet Explorer, so it should already be on your server machine. 

Database Driver Software on Web Server Machine

ProblemTracker requires Microsoft Data Access Components (MDAC) 2.5 or greater and JET 4.0 Service Pack 
5 (JET 4.0 SP5) or greater on the web server machine on which you are going to install ProblemTracker (this is 
true even if you are going to use SQL Server or Oracle for your workgroup database(s)). If you are using SQL 
Server (7.0 or 2000) or Oracle (8i or 9i), you will also need to install additional (client) software described in 
detail below on the web server machine. 

MDAC 2.5
If you are using Windows Server 2003 or Windows 2000, then MDAC 2.5 or greater is already installed. 
Otherwise, you should check the MDAC version on your machine by running regedit (Start->Run..., enter 
regedit.exe) and check the "FullInstallVer" value under the key 
HKEY_LOCAL_MACHINE\Software\Microsoft\DataAccess. It should be 2.50.x or greater. If it is not, then 
you should download and install MDAC 2.5 or greater (we recommend MDAC 2.5 Service Pack 2) from the 
Microsoft MDAC Downloads page. 

JET 4.0 Service Pack 5 or Greater
If you are using Windows Server 2003 or Windows 2000 Server Service Pack 2 (SP2) or greater, then you 
already have JET 4.0 Service Pack 5 installed. You can also verify whether you have JET 4.0 SP5, by finding 
the file msjetoledb40.dll (typically in C:\Windows\System32) in Windows Explorer, right-clicking on the file, 
selecting Properties, clicking on the Version tab and verifying that the File Version is 4.00.4331.4 or greater. If 
you do not have JET 4.0 SP5 (or greater) or are not sure you have it, you should download and install JET SP5 
from the JET 4.0 Service Pack Download page. After installing the JET service pack, please be sure to reboot 
your machine before attempting to install ProblemTracker. 

SQL Server (7.0 and 2000)
Note: We recommend that you do not use SQL Server 7.0 with new ProblemTracker installations as 
Microsoft is planning to discontinue Mainstream Support for SQL Server 7.0 at the end of 2005. Please 
use SQL Server 2000 with new ProblemTracker installations. If you are using SQL Server 7.0 or SQL 
Server 2000 as your database server for one or more ProblemTracker workgroups and SQL Server is not 
already installed on the web server (ProblemTracker will be connecting to a remote SQL Server system), you 
must have the SQL Server client connectivity software (e.g. SQL Server client drivers, SQL Server Client 
Network Utility, etc.) installed on the web server machine. Some information on installing this software is 
included in Microsoft Knowledge Base article Q303747. Please consult the SQL Server documentation or 
contact Microsoft Technical Support for further information on installing the SQL Server client software. Note: If 
SQL Server is installed on a different machine than ProblemTracker (it is not installed on the web server 
machine), you must ensure that (a) there is no firewall software or hardware that prohibits a TCP/IP 
connection from the web server to the database server and (b) the client software configuration (in the 
SQL Server Client Network Utility) for the TCP port matches that of the server (by default port 1433 is used; 
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however, unless you have just installed the software, someone may have changed the default configuration at 
the server and/or the client). 

Oracle Database 8i
Note: We strongly recommend that you do not use Oracle Database 8i with new ProblemTracker 
installations as Oracle has discontinued Error Correction Support for 8i (see Note 120607.1 and Note 
148054.1 in Oracle Metalink for further information on 8i desupport). If you are using Oracle 8i as your 
database server for one or more ProblemTracker workgroups, you must have the Oracle Client software 
installed on the web server machine. The Oracle Client software must be version 8.1.7.4.1 (8i Release 3 plus 
patch set 2376472) or greater. Additionally, you must update the Oracle Provider for OLE DB (installed with the 
Oracle Client) to version 8.1.7.3.2 by applying patch set 2110608 (8.1.7.3.0) followed by patch set 2400421 
(8.1.7.3.2). Simply updating the Oracle Client software using the 8.1.7.4.x patch set will not update the Oracle 
Provider for OLE DB which is used by ProblemTracker. The bug fixes to the Oracle Provider for OLE DB 
included in patch sets 2400421 and 2110608 are required for ProblemTracker to function properly. 
Browse to Oracle Metalink or contact Oracle Technical Support for further details on how to download and 
install patch sets 2376472, 2110608, and 2400421 (or to check for newer/updated patch sets). As of the 
publication of this document, 8.1.7.4 is the terminal release of the Oracle 8i Database (client and server) and 
8.1.7.3.2 is the terminal release of the Oracle (8i) Provider for OLE DB (which is included with the Oracle Client, 
but updated/patched separately). Oracle 8i Release 2 and Oracle 8i Release 1 are not supported for use with 
ProblemTracker (see desupport notices on Oracle Metalink for Oracle desupport dates for each of these 
releases). 

Oracle Database 9i
If you are using Oracle 9i as your database server for ProblemTracker, you must have the Oracle Client 
software installed on the web server machine. The Oracle Client software must be version 9.2.0.4.0 (9i Release 
2 plus patch set 3095277) or greater. Additionally, you must update the Oracle Provider for OLE DB (installed 
with the Oracle Client) to version 9.2.0.4.0 by applying patch set 3262468 (9.2.0.4.0). Simply updating the 
Oracle Client software using the 9.2.0.4.x patch set will not update the Oracle Provider for OLE DB which is 
used by ProblemTracker. The bug fixes to the Oracle Provider for OLE DB included in patch set 3262468 
are required for ProblemTracker to function properly. Browse to Oracle Metalink or contact Oracle 
Technical Support for further details on how to download and install patch sets 3095277 and 3262468 (or to 
check for newer/updated patch sets). Oracle 9i Release 1 is not supported for use with ProblemTracker (see 
the desupport notice on Oracle Metalink for Oracle desupport dates for 9i Release 1). 

Oracle Database 10g
If you are using Oracle 10g as your database server for ProblemTracker, you must have the Oracle Database 
10g Client software installed on the web server machine. The Oracle Client software must be version 10.1.0.2 
or greater. Browse to Oracle Metalink or contact Oracle Technical Support for further details on how to install 
Oracle Database 10g software. 

Database Server Software

If you plan to use Microsoft Access as your database, you don't need to install any software. The Access 
drivers that ProblemTracker uses are included with MDAC, so you have completed preparation for installing 
ProblemTracker. For information on maintenance of your Access database(s), please review the Database 
Administration section of the Workgroup Management Guide. 
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SQL Server 7.0 and 2000
If you plan to use Microsoft SQL Server as your database, you need to install this prior to installing 
ProblemTracker. It should either be installed on the web server machine which you plan to use for 
ProblemTracker or on a machine that can be accessed over the network from the web server machine (via 
TCP/IP). It is generally easier to configure if it is installed on the web server machine (no possible firewall or 
network issues); however, a remote database may have better performance (because it won't use resources on 
your web server machine, although, that must be weighed against network delays in communicating with the 
database server machine). After you install SQL Server and prior to installing ProblemTracker, you must 
configure it to use SQL Server Authentication. This type of authentication is used by ProblemTracker when 
communicating with SQL Server. Instructions on how to do this are below. 

1.  Start the Microsoft SQL Server Enterprise Manager. 
2.  Expand the tree in the left pane until you find the database server you wish to use (its name is usually 

the name of the machine on which it is running). 
3.  Right click on the server entry in the left pane and select "Properties...". 
4.  Click on the "Security" tab. 
5.  Select "SQL Server And Windows NT". 
6.  Click on OK. 

Oracle Database 8i, 9i, or 10g
If you plan to use Oracle as your database, you need to install this prior to installing ProblemTracker. It should 
either be installed on the web server machine which you plan to use for ProblemTracker or on a machine that 
can be accessed over the network from the web server machine (via TCP/IP). It is generally easier to configure 
if it is installed on the web server machine (no possible firewall or network issues, no need to update the client 
configuration with each new database name); however, a remote database may have better performance 
(because it won't use resources on your web server machine, although, that must be weighed against network 
delays in communicating with the database server machine). If you are using Oracle Database 8i, you must be 
using version 8.1.7.4 (8i Release 3 plus patch set 2376472) or greater on the server. Oracle 8i Release 1 and 
Oracle 8i Release 2 are not supported. If you are using Oracle Database 9i, you must be using version 9.2.0.4 
(9i Release 2 plus patch set 3095277) or greater. Oracle 9i Release 1 is not supported. If you are using Oracle 
Database 10g, you must be using version 10.1.0.2 or greater. Please browse to Oracle Metalink or contact 
Oracle Technical Support for further details on how to download and install patch set 2376472 or patch set 
3095277 (or to check for newer/updated patch sets). 

SQL Server and Oracle
After you have installed ProblemTracker, please schedule regular SQL Server or Oracle backups of 
your ProblemTracker database(s). Unlike a standard windows application (or Microsoft Access 
database file), SQL Server and Oracle database files are not standard files and can not be backed up by 
a simple file copy or simple file backup to tape. If you do not schedule backups via SQL Server, Oracle or 
via backup software that connects with SQL Server / Oracle to perform a backup, you will not be able to restore 
your data in the event of a hard disk failure or other hardware/software failure. Please consult your SQL Server 
/ Oracle manuals for directions on how to backup your database. Please review the Database Administration 
section of this Help document for details on the name(s) of the ProblemTracker database(s). If you are 
uncomfortable with these procedures we would strongly recommend that you use Microsoft Access as your 
database. A simple file backup will work and, while a lot of factors can affect performance, if you are using a 
server with our recommended hardware configuration, an Access database should be able to handle five 
thousand problem records per ProblemTracker workgroup (perhaps more if you have a newer server). 

Anti-Virus Software
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Temporarily disable any anti-virus software while you run the installation program and perform configuration 
steps in the Workgroup Management System (WMS). This is recommended so that your anti-virus software will 
not prevent the installation program or WMS from performing operations such as copying files, running scripts, 
configuring your web server, setting file permissions and registry entries. Your anti-virus software can be 
reactivated safely after you have completed the installation steps and any necessary WMS configuration. 
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Installing ProblemTracker Software

To install ProblemTracker software, please follow the instructions on our web site or those included with your 
license or evaluation email. Temporarily disable any anti-virus software while you run the installation program 
and perform configuration steps in the Workgroup Management System (WMS). This is recommended so that 
your anti-virus software will not prevent the installation program or WMS from performing operations such as 
copying files, running scripts, configuring your web server, setting file permissions and registry entries. Your 
anti-virus software can be reactivated safely after you have completed the installation steps and any necessary 
WMS configuration. To install ProblemTracker, login as Administrator on the web server machine on which you 
would like to install ProblemTracker and run the self-extracting .exe file you downloaded or the setup.exe 
program on the CD you received. During the installation, you will be asked to select a time zone. For a list of 
available time zones in your operating system, please refer to one of the following sections: 
Windows 2003 / XP / 2000 Time Zones 
Windows NT 4.0 Time Zones 
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If you are starting a trial of ProblemTracker, you can skip this section. A license key does not need to be 
entered at this time. 

Entering License Information

When you purchase a license for ProblemTracker, you will receive a license key (or multiple keys depending on 
the type of licenses and options you have purchased) that enables the product beyond the trial period. To enter 
this key, run the ProblemTracker License Manager program that was installed with ProblemTracker. You 
should be able to run this program from the Start button following this menu: 

Start > Programs > NetResults ProblemTracker > ProblemTracker License Manager
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The General tab of the License Manager contains the product (ProblemTracker or ProblemTracker Enterprise 
Edition), your trial status (how many days remain in your trial period), and a summary of the license keys you 
have entered and features that are enabled. Please review the information below for each of the user and 
feature licenses that you have purchased. 

The About tab of the License Manager contains the major version information, copyright, and a link to the 
License Agreement. 

Each key type has its own tab in the License Manager. When entering each license key, be sure to fill out all 
fields in the section, then click on the Enter Key button after entering the information. 

Each software key is matched to a particular email address (also provided when the product is ordered) so it is 
important that both the email address and key be entered exactly as given in the email containing your license 
information (case does matter). And, the email address associated with a license key can only be changed 
when you purchase additional licenses of the same type. 
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To remove a license key, click on the Remove Key, then select "Yes" to confirm the operation. 

To replace a license key, click on the Remove Key, then select "Yes" to confirm the operation. Enter the new 
license key information, then click on the Enter Key button. 

User License Types

Three special system accounts are built into each ProblemTracker workgroup: Admin, TBD, and Inet. These 
three "users" do not count against the user license limits listed below and are automatically included in each 
workgroup that you create. The Admin user account is included to allow you to configure and maintain a 
ProblemTracker workgroup. You can log in as this user to customize a workgroup to meet your requirements. 
The TBD user account is used in the Assignee (owner) field to represent "no one." For instance, it may be used 
for open issues that have yet to be assigned to someone or closed issues that no longer require any work. The 
Inet ("Internet") user is used in the Reporter field to represent all users who have reported issues via the Inet 
Page (people without a user account to identify them). Neither the Inet nor the TBD User ID can be used to log 
in to ProblemTracker. 

The remaining user accounts in ProblemTracker must have one of the following license types: Static, Floating, 
or Restricted. For all three license types only one user (person) may be logged in to ProblemTracker per 
license. In other words, the maximum number of people that may be logged in to ProblemTracker at any one 
time is equal to the total number of Static, Floating, and Restricted licenses you have. The difference between 
the license types is how many user accounts may be created per license and what ProblemTracker features 
may be used. 

●     Static (Named) User Licenses
One user account (User ID) may be created for each Static license. Since there is only one user 
account per license, users with Static accounts can always log in to ProblemTracker. Static licenses are 
typically used for people who regularly use ProblemTracker and therefore must be guaranteed access 
at any time. 

Static users are also referred to as "Unrestricted" or "Non-restricted" users in various areas of the Help 
Guides. See the License Administration section of the Workgroup Management System for further 
information on configuration of Static user accounts. 

●     Floating (Concurrent) User Licenses
Up to ten (10) user accounts (User IDs) may be created for each Floating license. However, only one 
person per Floating license may be logged in to ProblemTracker at one time. Others who try will be 
denied access until another Floating license user logs off (clicks the Logoff icon). For instance, if you 
have 5 Floating licenses, you can have up to 50 Floating user accounts, but no more than 5 of those 50 
users may be logged in to ProblemTracker at the same time. Floating licenses are typically used for 
infrequent users if it is acceptable that they may not be able to login to the system some of the time (as 
all Floating licenses may be in use). Although you can create up to ten user accounts per Floating 
license, we generally recommend one Floating license for every two to three users to minimize the 
number of times users can not log in because all Floating licenses are in use. 

If you have purchased only Floating licenses, then after entering your license information (in the 
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"Floating" tab of the License Manager), you should log in to the Workgroup Management System and 
use the Edit User operation to convert your existing trial accounts, if any, to Floating user accounts (as 
all trial user accounts are configured as Static user accounts). Until all user accounts are set up as 
Floating user accounts, your users will not be able to login to ProblemTracker. 

Floating users are also referred to as "Unrestricted" or "Non-restricted" users in various areas of the 
Help Guides. See the License Administration section of the Workgroup Management System for further 
information on configuration of Floating user accounts. 

●     Restricted User Licenses
One user account (User ID) may be created for each Restricted license. Since there is only one user 
account per license, users with Restricted accounts can always log in to ProblemTracker. However, 
unlike the Static and Floating license types, users with Restricted user accounts can only perform a very 
limited number of ProblemTracker operations. They are only allowed to Add new records (report 
issues), View records that they previously added (check status on issues they have reported), and run 
text reports (Saved Queries) on the Home page to view summaries of records they have added. A 
Restricted user can not perform any other operations (such as Edit, Task, Delete, Query, Metrics, 
History, Discuss, etc.); can not be the Assignee for a record; can not display Metrics (Saved Charts) on 
the Home page; can not view information about alerts, discussions, or source code files; and can not 
view any records which she did not Add. Restricted licenses are typically used for external users who 
only need to submit issues to ProblemTracker and track the progress of these issues. For example, if 
you have a large number of customers who only submit reports to your Support organization very 
infrequently, you could give those users Restricted licenses. 

See the License Administration section of the Workgroup Management System for further information 
on configuration of restricted user accounts. 

Feature License Types

The following license types are available to support ProblemTracker features: 

●     Inet Page
The Inet Page is a form used to anonymously submit records to ProblemTracker. For example, it can be 
used as a web based suggestion box. A user who submits a record through the Inet page is not 
required to login to ProblemTracker. However, since the user does not have a user account, they will 
not be identified in the record (Reporter field will be set to Inet), will not receive email notifications from 
ProblemTracker, can not log in to ProblemTracker to view the status of the issue they reported, and can 
not have issues assigned back to them for verification (e.g. to sign off on the resolution of the issue). To 
receive email notifications (e.g. automatic updates when an issue is resolved) and/or login to 
ProblemTracker to check on status of the issue, the user must at least have a Restricted user account. 
To be able to have an item assigned back to the person who reports it, the user must have a Floating or 
Static user account. 

After entering the license key, refer to the Inet Page section for information about enabling this feature. 

●     Alerts - Enterprise Edition only
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The Alerts feature is only available in ProblemTracker Enterprise Edition. It allows an email notification 
message about a particular record to be sent at a future date and time to any user(s) and/or user 
group(s). The date & time for the Alert can be set directly (absolute) or relative to another date & time 
(e.g. 2 days before a due date). Alerts can be used as reminders about records or deadlines within a 
record. Alerts can also be used as a means of escalation, as Alerts can be triggered by a lack of change 
in Status in a record (e.g. if no one is assigned to process an issue within a given amount of time an 
Alert will be sent). 

After entering the license key, please review the Customizing Alerts section for the steps needed to 
enable this feature. 

●     Discussion - Enterprise Edition only
The Discussion feature is available only in ProblemTracker Enterprise Edition. It allows users to 
collaborate on topics related to a particular record in parallel to a record's progress through the 
workflow. Discussion is similar to a newsgroup or message board, where users can be invited to post 
their comments and are informed of updates to the discussion via email. 

After entering the license key, please review the Customizing Discussion section for the steps needed 
to enable this feature. 

●     Add via Email
The Add Record via Email feature allows users to submit issues to ProblemTracker by sending an email 
message. You may wish to use this if ProblemTracker is installed on an internal web server which 
cannot be browsed to by external users (a web server behind your corporate firewall). Users who are 
out of the office (outside the firewall) can still submit new issues by sending email to a standard POP3 
or IMAP email account on your corporate mail server. ProblemTracker can then read the email by 
connecting to your corporate mail server and Add a new record with the email content (including, 
optionally, any email attachments). 

After entering the license key, please review the Add Records Via Email section for the steps to enable 
this feature. 

●     Knowledge Base
Knowledge Base is a feature that is used to publish articles about known issues, frequently asked 
questions, tech notes, or other information that can be searched by your end users. It includes the full 
ProblemTracker workflow engine so that your process of creating, reviewing, and updating Knowledge 
Base articles can be automated and enforced by ProblemTracker. 

Note: Your Knowledge Base license key will include a maximum number of Knowledge Base articles. 
This number is the total number of Knowledge Base articles that you are licensed to publish in all 
ProblemTracker workgroups combined (it is not per workgroup). 

After entering the license key, please review the Knowledge Base section for the steps to configure this 
feature. 

●     API
The Application Programming Interface (API) allows you to add records to ProblemTracker from an 
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external application. For example, you can use this feature to create a gateway between a legacy 
system and your ProblemTracker installation. 

To use this feature, the NetResults ProblemTracker Software Development Kit (SDK) must be installed 
on the machine that runs the external application. The external application can be running on the same 
machine as ProblemTracker or on a remote machine that meets the ProblemTracker SDK installation 
requirements. Please review the SDK Help documentation available in the Start Menu after installing 
the NetResults ProblemTracker SDK. This can be reached by going to: 

Start > Programs > NetResults ProblemTracker SDK > ProblemTracker SDK Help 

Note: You must purchase one ProblemTracker API/SDK client license for each (client) application 
which uses the API to connect (add records) to your ProblemTracker installation. 

License Agreement

The ProblemTracker (or ProblemTracker Enterprise Edition) License Agreement can be found in the License 
Manager by clicking on the License Agreement... button at the bottom of the General tab or the About tab. 
Please review this for the specific terms and conditions of your license(s). 
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Creating a Workgroup  

After completing the installation process, the next step is to create a workgroup(s) . If you chose to install the 
default workgroup during the installation set up program, you can begin using this workgroup immediately. To 
login to the default workgroup, you can browse to: 

http://servername/pteval/ptlogin.asp 

where servername is the TCP/IP name of the machine where ProblemTracker is installed. Alternatively, you 
can get to this default workgroup from the machine where ProblemTracker is installed by going to 

Start > Programs > NetResults ProblemTracker > Evaluation Workgroup 

If you wish to create an alias for this default workgroup, please refer to the Managing Aliases section of the 
Workgroup Management System Guide. 

To create a new workgroup(s), please refer to the Adding a Workgroup section of the Workgroup Management 
System Guide. 
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Browser Settings  

ProblemTracker does not require any special plugins or unusual browser configuration. So, by default, almost 
all browsers are already configured for use with ProblemTracker. However, if support for cookies or JavaScript 
have been disabled in your browser configuration, then you may need to modify the settings. Information on 
that is below. If such support has not been disabled, you can skip to the next section. 

Brower Settings

ProblemTracker uses browser cookies to maintain its state during a session. And, it uses JavaScript to provide 
data validation on the client side (which improves overall system performance). In order to use ProblemTracker, 
you must enable the setting of cookies and use of JavaScript in your browser. 

By default, most browsers have cookies enabled. However, you can use the table below to determine where to 
verify that cookies are enabled on your browser. 

Beginning in IE 6, there are multiple levels for enabling cookies. It is recommended that the default option, 
Medium, is selected. 

Browser Menu

Netscape 6.2 Edit->Preferences->Privacy & Security->Cookies 
IE 5 Tools->Internet Options->Security->Custom Level->Cookies 
IE 6 Tools->Internet Options->Security->Privacy (select Medium) 

By default, most browsers have JavaScript enabled. However, you can use the table below to determine where 
to verify that JavaScript is enabled on your browser. 

Browser Menu

Netscape 6.2 Edit->Preferences->Advanced->Enable JavaScript 
IE 5 Tools->Internet Options->Security->Custom Level->Scripting->Active Scripting 
IE 6 Tools->Internet Options->Security->Custom Level->Scripting->Active Scripting 
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Program URLs  

Overview

ProblemTracker is a web application and is accessed by using a standard web browser. Once installed on a 
web server by the ProblemTracker Administrator, you can access ProblemTracker by entering the appropriate 
URL into your browser. 

Starting ProblemTracker

Once installed, ProblemTracker can be accessed via the following URL: 

http://servername/workgroup/ptlogin.asp 

where servername is the TCP/IP name of the host where the ProblemTracker server software is installed, and 
workgroup is the name of the ProblemTracker workgroup. 

For example, if you installed the default workgroup on a server named MYSERVER, you would use this URL: 

http://MYSERVER/pteval/ptlogin.asp 

Optionally, you can browse to any ProblemTracker workgroup by omitting the "ptlogin.asp" from the URL above 
as that is configured as the default page for each workgroup. 

This will present the ProblemTracker login screen where you can enter your User ID and Password. If this is 
your first time using ProblemTracker, please see your Administrator for your User ID and Password or if 
available below the Login button, click on the link New User? Register Here to create a new user account. If 
you are the Administrator and this is your first time using ProblemTracker, please login using Admin as the 
User ID and Admin as the Password. Then, please change the password for the Admin user account. 
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If you do not wish to configure web server security (perhaps your web server is on an internal machine behind a 
"firewall"), you have completed ProblemTracker installation and configuration. You can now login to 
ProblemTracker or proceed to the ProblemTracker tutorial. 

ProblemTracker Security

ProblemTracker supports security at two levels. The product includes a flexible user group based security 
scheme, allowing control of access to both function (Add, Edit, View, etc.) and data records. In addition, 
ProblemTracker also supports the use of your web server's native security mechanisms to limit access to the 
web pages themselves. If you have very strict security requirements, you may wish to apply authentication to 
your ProblemTracker installation to restrict access to the relevant web pages based on function. By default, the 
ProblemTracker installation sets up anonymous access for the workgroups and a combination of Basic and 
Integrated Windows authentication for the Workgroup Management System. The section below provides a 
description of the default security configured by the installation set up program. 

Default Security Set by the Installation

The ProblemTracker installation program creates 2 user accounts: PUSR4HOSTNAME and 
PADM4HOSTNAME where HOSTNAME is the TCP/IP host name of the machine where ProblemTracker is 
installed. PUSR4HOSTNAME is used as the anonymous user account for accessing the workgroups. 
PADM4HOSTNAME is used as the account to perform operations in the Workgroup Management System 
(WMS). Use of the operations in WMS always require local Administrator credentials. 

The following table displays the minimum file permissions needed to use the ProblemTracker workgroups and 
WMS with the default installation setup. 

Note that the following table assumes that a workgroup named pteval, the Evaluation Workgroup, has been 
installed. For your workgroup, substitute your workgroup name where "pteval" appears. rootDir is the web 
server root directory where the ProblemTracker content and web files were installed (by default, 
C:\Inetpub\wwwroot\ProblemTracker). winDir is the operating system root directory (for example, 
C:\WinNT). programfilesDir is the location where the ProblemTracker installation files were installed (by 
default, C:\Program Files\NetResults\ProblemTracker5). 
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Directory and/or File User or User Group - 
Permissions Required

rootDir and all subdirectories Administrators - Full 
Control

rootDir/ptadmin and all subdirectories Administrators - Full 
Control

rootDir/ptadmin/Database 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Read

rootDir/ptadmin/Database/ptadmin.mdb 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Read

rootDir/ptcgiadmin and all subdirectories 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Read and Execute

rootDir/ptcommon and all subdirectories Administrators - Full 
Control

rootDir/ptcommon/Database 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/ptcommon/Database/ptcommon.mdb 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/pttemplate and all subdirectories 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Read

rootDir/pttmp 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/pteval and all subdirectories 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Read
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rootDir/pteval/Attachments 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/pteval/Database 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/pteval/Database/bugtrack.mdb 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

rootDir/pteval/Importer/ProblemTracker and all 
subdirectories 

Administrators - Full 
Control
PUSR4HOSTNAME - 
Modify

winDir/temp (and/or) winDir/tmp 

Administrators - Read, 
Write
PUSR4HOSTNAME - 
Read, Write

programfilesDir Administrators - Full 
Control

C:\Documents and Settings\All Users\Application 
Data\Microsoft\Crypto\RSA 

Administrators - Read, 
Write
PUSR4HOSTNAME - 
Read, Write

C:\Documents and Settings\All Users\Application 
Data\Microsoft\Crypto\RSA\MachineKeys 

Administrators - Read, 
Write
PUSR4HOSTNAME - 
Read, Write

Applying Basic Authentication to Restrict Access by Function

Many web servers allow you to restrict access to a web site on a per user basis via a process called Basic 
Authentication. ProblemTracker has been designed with this in mind, allowing you to limit access to any 
function by using the web server's built-in security mechanism. 

Note: In the sections below we have described how to set up Basic authentication because that is support by 
all browsers which are supported by ProblemTracker. However, if your users are exclusively using Internet 
Explorer, you can instead (or additionally) configure Integrated Windows authentication (a stronger form of 
authentication than Basic authentication). To configure Integrated Windows authentication, check the 
Integrated Windows authentication box instead of (or in addition to) the Basic authentication box when 
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instructed to do so in the following sections. 

ProblemTracker Organization

The ProblemTracker web pages are organized by function as shown in the following table. In general all pages 
related to a particular function have been included in the same directory, using a common program file. By 
applying security to these directories and program files as desired, you can limit each individual or group in 
your organization to the functions appropriate to their job. When a user browses to a page or program where 
security has been applied, a dialog appears in their browser requiring them to enter a username and password. 
Depending upon their identity, they will be allowed or denied access to the resource. 

Note that the following table assumes that a workgroup named pteval, the Evaluation Workgroup, has been 
installed. For your workgroup, substitute your workgroup name where "pteval" appears. rootDir is the web 
server root directory where the ProblemTracker content and program files were installed (by default, 
C:\Inetpub\wwwroot\ProblemTracker). 

Function Directory

Workgroup Management System (WMS) 
Administrative Functions 

rootDir/ptadmin
rootDir/ptcgiadmin
rootDir/ptcommon
rootDir/pttemplate
rootDir/pttmp

Workgroup Administrative Functions rootDir/pteval/Admin
rootDir/pteval/Importer

Normal Internal User Operations rootDir/pteval/Intranet
rootDir/pteval/Images

External User Operations rootDir/pteval/Internet 

Add Record rootDir/pteval/Intranet/Add 

Edit Record rootDir/pteval/Intranet/Edit 

View Record rootDir/pteval/Intranet/View 

Advance Record State rootDir/pteval/Intranet/Task 

Delete Record rootDir/pteval/Intranet/Delete 

File Attachments rootDir/pteval/Attachments 

Generate Report rootDir/pteval/Intranet/Report 

Discussion - Enterprise Edition Only rootDir/pteval/Intranet/Discuss 

ProblemTracker Software Development Kit rootDir/pteval/API 
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Knowledge Base rootDir/pteval/KB 

Self Registration rootDir/pteval/SelfReg 

Documentation rootDir/pteval/Help 

Workgroup Management System Admin 
Documentation rootDir/ptadmin/Help 

Workgroup Admin Documentation rootDir/pteval/Help/Admin 

User Documentation rootDir/pteval/Help/Std 

All Workgroup functions need at least Read permission on rootDir/pteval/Include directory. 

Setting Web Server Security

The procedure for configuring web server security varies for each web server product. This document provides 
general instructions for setting up security as it relates to ProblemTracker for the following web servers. 
However, you should also consult the documentation provided with your web server for details regarding its 
security options. 

●     Microsoft IIS 6.0 (Windows Server 2003) 
●     Microsoft IIS 5.0 (Windows 2000 Server) 
●     Microsoft IIS 4.0 & NT 4.0 Personal Web Server (Windows NT 4.0) 

WMS Operations that can impact your Custom Security Settings

The Repair, Move, and Upgrade operations that can be performed in the Workgroup Management System can 
reset the customized security you have applied to the locations listed in the table above. Before you use the 
Repair, Move, or Upgrade operations, it is recommended that you take note of the security scheme you have 
applied, then re-apply these changes after using one of those operations. 

For more information on the WMS operations, please refer to the following sections in the WMS Help Guide: 

Repairing a Workgroup
Moving a Workgroup
Upgrading a Version 3 Workgroup
Upgrading a Version 4 or 5 Workgroup 
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Applying Security Using IIS 6.0 (Windows 
Server 2003) 

 

Overview

Microsoft Internet Information Services (IIS) 6.0 bundled with Microsoft Windows Server 2003 uses Active 
Directory, ADSI, WMI, and Directory Services to set/read permissions to provide security for the web pages. IIS 
6.0 uses the native security features of the NTFS file system and Active Directory Users and Computers (or 
Computer Management Console) to provide security for web pages. In order to password protect 
ProblemTracker on this web server you must install it on an NTFS file system. Microsoft Windows Server 2003 
provides tightly integrated and flexible security. Thus the security permissions on the Windows Server 2003 
directories are very restrictive by default. 

Instructions

The following instructions assume a workgroup named ptdev is installed. For your workgroup, substitute your 
workgroup name for "ptdev" in the steps below. 

1.  Enable Password Protection 
❍     Start the Internet Services Manager (Start > Programs > Administrative Tools > Internet 

Services Manager). 
❍     Double click on the computer/domain name under the folder "Internet Information Services". 
❍     Double click on "Web Sites". Select the Default Web Site or a Web Site in which the 

ProblemTracker virtual directories (e.g. ptdev) are created. 
❍     Double click on the content directory folder (e.g. "pteval") in the left window pane. The files 

included in the pteval folders are displayed in the right window pane. 
❍     For each file or folder that you would like to password protect, repeat the following steps: 

■     Right click on the file or directory. A pull down menu appears. Select Properties. 
■     Select the File Security (or Directory Security) tab. 
■     Click on the Edit... button in the Authentication and Access Control. 
■     Uncheck the box for Enable Anonymous Access 
■     Check the box for Basic Authentication. A warning dialog box will pop up. Select "Yes". 
■     Type the appropriate domain for your web server in the default domain box. 
■     Click Apply and then OK in the Properties dialog box. 

2.  Set File/Directory Security on Windows Server 2003 
❍     Start the Windows 2003 Explorer (Start > Programs > Accessories > Windows Explorer) 
❍     Select the directory where ProblemTracker is installed, e.g. "pteval". 
❍     In the right pane of the Explorer, select the directory or file(s) you would like to limit access to. 

You can select multiple items by holding down the CTRL key on your keyboard as you click on 
files. 

❍     With the files or the directory highlighted, go to the File > Properties menu or right click and 
choose the Properties menu, then click on the Security tab of the dialog 

❍     By default "PUSR4<HOSTNAME>" where <HOSTNAME> is the TCP/IP name of the server 
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where ProblemTracker is installed will have all the check boxes checked (and grayed) under the 
column Allow and none checked under the column Deny. 

❍     Delete the default permission for "PUSR4<HOSTNAME>" and any others that grant access to 
anyone you do not wish to have access to the selected directory or files, by selecting those 
users and clicking the Remove button. If you do not wish for an individual to see a web page, 
make sure the user does not have Read checkbox checked under the column Allow (or if the 
Read checkbox is checked and grayed then check the Read checkbox under the column Deny) 
for the file or directory. 

❍     Press the Add... button to display the "Select Users or Groups" dialog. Click Object Types... 
button and make sure that Groups and Users are checked (selected); otherwise, check them 
and click OK button. To change the "From this location" value, click Locations... button. Select 
your appropriate machine/domain and click OK. Now, type in the particular user/group (for 
example "Administrator") you would like to give access the selected directory or files. Click 
Check Names button to verify whether the user/group names that you typed in are valid. 
Correct any error reported. You can use the Advanced... button to search for any particular 
user/group. The users/groups will be listed in the list below. Now click OK to close this dialog. 
The users/groups chosen will get added to the list. You can grant/deny permissions for each 
user/group by checking/unchecking the checkboxes under the columns Allow and Deny. 

❍     Refer to the table in the Web Server Security Overview section to determine which content 
directories and program files you would like to protect based upon function. Then repeat the 
process described here for each of the directory. 

WMS Operations that can impact your Custom Security Settings

The Repair, Move, and Upgrade operations that can be performed in the Workgroup Management System can 
reset the customized security you have applied to the locations listed in the table above. Before you use the 
Repair, Move, or Upgrade operations, it is recommended that you take note of the security scheme you have 
applied, then re-apply these changes after using one of those operations. 

For more information on the WMS operations, please refer to the following sections in the WMS Help Guide: 

Repairing a Workgroup
Moving a Workgroup
Upgrading a Version 3 Workgroup
Upgrading a Version 4 or 5 Workgroup 
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Applying Security Using IIS 5.0 (Windows 2000 
Server) 

 

Overview

Microsoft Internet Information Services (IIS) 5.0 bundled with Microsoft Windows 2000 Server uses Active 
Directory, ADSI, and Directory Services to set/read permissions to provide security for the web pages. IIS 5.0 
uses the native security features of the NTFS file system and Active Directory Users and Computers (or 
Computer Management Console) to provide security for web pages. In order to password protect 
ProblemTracker on this web server you must install it on an NTFS file system. Microsoft Windows 2000 
provides tightly integrated and flexible security. Thus the security permissions on the Windows 2000 directories 
are very restrictive by default. 

Instructions

The following instructions assume a workgroup named ptdev is installed. For your workgroup, substitute your 
workgroup name for "ptdev" in the steps below. 

1.  Enable Password Protection 
❍     Start the Internet Services Manager (Start > Programs > Administrative Tools > Internet 

Services Manager). 
❍     Double click on the computer/domain name under the folder "Internet Information Services". 
❍     Select the Default Web Site or a Web Site in which the ProblemTracker virtual directories (e.g. 

ptdev) are created. 
❍     Double click on the content directory folder (e.g. "pteval") in the left window pane. The files 

included in the pteval folders are displayed in the right window pane. 
❍     For each file or folder that you would like to password protect, repeat the following steps: 

■     Right click on the file or directory. A pull down menu appears. Select Properties 
■     Select the File Security (or Directory Security) tab 
■     Click on the Edit... button in the Anonymous Access and Authentication Control 
■     Uncheck the box for Allow Anonymous Access 
■     Check the box for Basic Authentication. A warning dialog box will pop up. Select "Yes". 

Click on the Edit... button for Basic Authentication. 
■     An input dialog for Basic Authentication Domain will pop up. Select the appropriate 

domain for your web Server. In most cases it should be the local domain. If so, select 
Use Default and click on the OK button. 

■     Click OK in the Authentication Method dialog box. 
■     Click Apply and then OK in the Properties dialog box. 

2.  Set File/Directory Security on Windows 2000 Server 
❍     Start the Windows 2000 Explorer (Start > Programs > Accessories > Windows Explorer) 
❍     Select the directory where ProblemTracker is installed, e.g. "pteval" 
❍     In the right pane of the Explorer, select the directory or file(s) you would like to limit access to. 

You can select multiple items by holding down the CTRL key on your keyboard as you click on 
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files. 
❍     With the files or the directory highlighted, go to the File > Properties menu or right click and 

choose the Properties menu, then click on the Security tab of the dialog 
❍     By default "PUSR4<HOSTNAME>" where <HOSTNAME> is the TCP/IP name of the server 

where ProblemTracker is installed will have all the check boxes checked (and grayed) under the 
column Allow and none checked under the column Deny. 

❍     Delete the default permission for "PUSR4<HOSTNAME>" and any others that grant access to 
anyone you do not wish to have access to the selected directory or files, by selecting those 
users and clicking the Remove button. If you do not wish for an individual to see a web page, 
make sure the user does not have Read checkbox checked under the column Allow (or if the 
Read checkbox is checked and grayed then check the Read checkbox under the column Deny) 
for the file or directory. 

❍     Press the Add... button to display the "Select Users, Computers and Groups" dialog. Under 
"Look In:" pulldown, select your Windows 2000 domain name. Now add any particular 
user/group (for example "Administrator" you would like to give access the selected directory or 
files by selecting their names (press Ctrl to select multiple users/groups), and pressing the Add 
button. The users/groups will be listed in the list below. Now click OK to close this dialog. The 
users/groups chosen will get added to the list. You can grant/deny permissions for each 
user/group by checking/unchecking the checkboxes under the columns Allow and Deny. 

❍     Refer to the table in the Web Server Security Overview section to determine which content 
directories and program files you would like to protect based upon function. Then repeat the 
process described here for each of the directory. 

WMS Operations that can impact your Custom Security Settings

The Repair, Move, and Upgrade operations that can be performed in the Workgroup Management System can 
reset the customized security you have applied to the locations listed in the table above. Before you use the 
Repair, Move, or Upgrade operations, it is recommended that you take note of the security scheme you have 
applied, then re-apply these changes after using one of those operations. 

For more information on the WMS operations, please refer to the following sections in the WMS Help Guide: 

Repairing a Workgroup
Moving a Workgroup
Upgrading a Version 3 Workgroup
Upgrading a Version 4 or 5 Workgroup 

http://www.problemtracker.com/pthelp554/install/help_security_iis5.htm (2 of 2) [2/4/2005 12:03:21 PM]

http://www.problemtracker.com/pthelp554/WMS/bots_wms.htm
http://www.problemtracker.com/pthelp554/WMS/wms_toc.htm
http://www.problemtracker.com/pthelp554/WMS/bots_wms_repair.htm
http://www.problemtracker.com/pthelp554/WMS/bots_wms_move.htm
http://www.problemtracker.com/pthelp554/WMS/bots_wms_3xupgrade.htm
http://www.problemtracker.com/pthelp554/WMS/bots_wms_4xupgrade.htm


Applying Security Using IIS 4.0 & NT Personal Web Server

 NetResults ProblemTracker  

Applying Security Using IIS 4.0 & NT Personal 
Web Server 

 

Overview

NOTE: Microsoft intends to discontinue support of the Windows NT 4.0 platform as of January 1, 2004. 
As such, it is not recommended that you use Windows NT 4.0 for any new installations of 
ProblemTracker. More information on this change is available on the Microsoft NT Server web site. 

Internet Information Server 4.0 & NT Personal Web Server use the native security features of the NTFS file 
system and Windows NT user administration to provide security for web pages. In order to password protect 
ProblemTracker on any of these web servers you must install it on an NTFS file system. 

Instructions

The following instructions assume a workgroup named pteval is installed. For your workgroup, substitute your 
workgroup name for "pteval" in the steps below. 

1.  Enable Authentication 
❍     Start the Internet Service Manager 

NT Workstation
Start->Programs->Windows NT 4.0 Option Pack->Microsoft Personal Web Server->Internet 
Service Manager 

NT Server
Start->Programs->Windows NT 4.0 Option Pack->Microsoft Internet Information Server-
>Internet Service Manager 

❍     Select Default Web Site or a Web Site of your choice 
❍     Double click on the content directory folder (pteval) in the left window pane. The files included in 

the pteval folders are displayed in the right window pane. 
❍     For each file or folder that you would like to password protect, repeat the following steps: 

■     Right click on the file or directory. A pull down menu appears. Select Properties. 
■     Select the File Security (or Directory Security) tab. 
■     Press the Edit... button in the Anonymous Access and Authentication Control. 
■     Unselect Allow Anonymous Access. 
■     Select Basic Authentication. A warning dialog box will pop up. Press Yes. Press the 

Edit... button for Basic Authentication. 
■     An input dialog for Basic Authentication Domain will pop up. Select the appropriate 

domain for your Web Server. In most cases it should be the local domain. If so, select 
Use Default and press OK. 

■     Press OK in the Authentication Method dialog box. 
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■     Press Apply and then OK in the Properties dialog box. 

2.  Set File Security on Windows NT 
❍     Start the Windows NT Explorer 
❍     Select the directory where ProblemTracker is installed, e.g. pteval. 
❍     In the right pane of the Explorer, select the directory or file(s) you would like to limit access to. 

You can select multiple items by holding down the Control key as you click on files. 
❍     With the files highlighted, select the "File->Properties" menu, click on the Security tab of the 

dialog, and press the Permissions button. 
❍     The File Permissions dialog is displayed. By default it has the value "PUSR4<HOSTNAME> 

Modify" where <HOSTNAME> is the TCP/IP name of the machine where ProblemTracker is 
installed. Delete this row, and any others that grant access to anyone you do not wish to have 
access to the selected directory or files. If you do not wish for an individual to see a web page, 
make sure the user does not have Read (R) permissions for the file or directory. 

❍     Press the Add... button to display the Add Users and Groups dialog. Under "List Names From:" 
select your Windows NT domain and click on the Show Users button. Now add any particular 
user you would like to give access to the select directory or files by selecting their name, 
pressing the "Add" button, selecting the access type, and pressing OK. Repeat this process for 
any other users. 

❍     Back on the File Permissions dialog, press the Add... button to display the Add Users and 
Groups dialog. Under "List Names From:" select your machine (\\HostName*, where HostName 
is the name of your machine), and click on the Show Users button. Now add any users you 
defined earlier (e.g. Administrator) by selecting the name, pressing the "Add" button, selecting 
the appropriate access and pressing OK. 

❍     Press the OK button, and the OK button again. 
❍     Refer to the table in the Web Server Security Overview section to determine which content 

directories and program files you would like to protect based upon function. Then repeat the 
process described here for each. 

WMS Operations that can impact your Custom Security Settings

The Repair, Move, and Upgrade operations that can be performed in the Workgroup Management System can 
reset the customized security you have applied to the locations listed in the table above. Before you use the 
Repair, Move, or Upgrade operations, it is recommended that you take note of the security scheme you have 
applied, then re-apply these changes after using one of those operations. 

For more information on the WMS operations, please refer to the following sections in the WMS Help Guide: 

Repairing a Workgroup
Moving a Workgroup
Upgrading a Version 3 Workgroup
Upgrading a Version 4 or 5 Workgroup 
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Uninstalling ProblemTracker  

ProblemTracker fully supports Windows uninstall, and can be removed from the web server by using the icon 
labeled Repair-Uninstall ProblemTracker that is located in the ProblemTracker Program folder, or by using 
the Add/Remove Programs icon in the Control panel. This operation must be done while logged in as 
Administrator (or a user in the Administrators group) on the web server machine on which ProblemTracker is 
installed. After starting the Setup program from the ProblemTracker Program folder or Add/Remove Programs, 
click Next on the welcome dialog. Then select Remove and on the next dialog and click Next. You can also 
select Repair on this dialog to reinstall the ProblemTracker files, if you feel some of those files have been 
accidentally modified or removed. 

If you were using the Alerts feature, after uninstalling ProblemTracker you must manually delete the Scheduled 
Task created for the Alerts function. To do this, 

1.  Go to Start > Settings > Control Panel 
2.  Double click on Scheduled Tasks 
3.  Right click on the Scheduled Task used for ProblemTracker Alerts 
4.  Select Delete 

If you were using the Add Record via Email feature, after uninstalling ProblemTracker you must manually 
delete the Scheduled Task created for the Add via Email function. To do this, 

1.  Go to Start > Settings > Control Panel 
2.  Double click on Scheduled Tasks 
3.  Right click on the Scheduled Task used for ProblemTracker Emails 
4.  Select Delete 

http://www.problemtracker.com/pthelp554/install/bots_remove.htm [2/4/2005 12:05:16 PM]

http://www.problemtracker.com/pthelp554/Admin/bots_admin_alerts.htm
http://www.problemtracker.com/pthelp554/Admin/admin_addvemail_over.htm


Windows 2003 / XP / 2000 Time Zone Selection Chart

 NetResults ProblemTracker  

Windows 2003 / XP / 2000 Time Zone 
Selection Chart 

 

The following is a list of time zones that are supported by ProblemTracker when installed on a Windows 2003 / 
XP / 2000 system. Entries with (*) are only available in Windows 2003 and XP. 

Time Zone 
Offset (in 
Hours)

Time Zone
System Time Zone (as 
displayed in Date/Time 
Settings)

-12:00 Dateline Standard Time Eniwetok, Kwajalein

-11:00 Samoa Standard Time Midway Is, Samoa

-10:00 Hawaiian Standard Time Hawaii

-10:00 Alaskan Standard Time Alaska

-08:00 Pacific Standard Time Pacific Time (US & Canada); 
Tijuana

-07:00 Mexican Standard Time[La 
Paz](*) Chihuahua, La Paz, Mazatlan

-07:00 Mountain Standard Time Mountain Time (US & 
Canada)

-07:00 Mountain Standard Time 
[Arizona] Arizona

-06:00 Central Standard Time Central Time (US & Canada)

-06:00 Mexico Standard Time Mexico City, Tegucigalpa

-06:00 Canada Central Standard 
Time Saskatchewan

-06:00 Central America Standard 
Time Central America

-05:00 Eastern Standard Time Eastern Time (US & Canada)
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-05:00 Eastern Standard Time 
[Indiana (East)] Indiana (East)

-05:00 SA Pacific Standard Time Bogota, Lima, Quito

-04:00 Atlantic Standard Time Atlantic Time (Canada)

-04:00 SA Western Standard Time Caracas, La Paz

-04:00 Pacific SA Standard Time Santiago

-03:30 Newfoundland Standard 
Time Newfoundland

-03:00 SA Eastern Standard Time Buenos Aires, Georgetown

-03:00 E. South America Standard 
Time Brasilia

-03:00 Greenland Standard Time Greenland

-02:00 Mid-Atlantic Standard Time Mid-Atlantic

-01:00 Azores Standard Time Azores

-01:00 Cape Verde Standard Time Cape Verde Is

00:00 Universal Coordinated Time Casablanca, Monrovia

00:00 Greenwich Mean Time
Greenwich Mean Time: 
Dublin, Edinburgh, Lisbon, 
London

+01:00 Romance Standard Time Amsterdam, CopenHagen, 
Madrid, Paris, Vilnius

+01:00 W. Central Africa Standard 
Time West Central Africa

+01:00 Central European Standard 
Time

Belgrade, Sarajevo, Skopje, 
Sofija, Zagreb

+01:00 Central Europe Standard 
Time

Bratislava, Budapest, 
Ljubljana, Prague, Warsaw

+01:00 W. Europe Standard Time Brussels, Berlin, Bern, Rome, 
Stockholm, Vienna
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+02:00 Egypt Standard Time Cairo

+02:00 South Africa Standard Time Harare, Pretoria

+02:00 Israel Standard Time Israel

+02:00 E. Europe Standard Time Bucharest

+02:00 FLE Standard Time Helsinki, Riga, Tallinn

+02:00 GTB Standard Time Athens, Istanbul, Minsk

+03:00 Arab Standard Time Kuwait, Riyadh

+03:00 E. Africa Standard Time Nairobi

+03:00 Arabic Standard Time Baghdad

+03:00 Russian Standard Time Moscow, St. Petersburg, 
Volgograd

+03:30 Iran Standard Time Tehran

+04:00 Arabian Standard Time Abu Dhabi, Muscat

+04:00 Caucasus Standard Time Baku, Tbilisi

+04:00 Afghanistan Standard Time Kabul

+05:00 West Asia Standard Time Islamabad, Karachi, Tashkent

+05:00 Ekaterinburg Standard Time Ekaterinburg

+05:30 India Standard Time Bombay, Calcutta, Madras, 
New Delhi

+05:45 Nepal Standard Time Kathmandu

+06:00 Central Asia Standard Time Almaty, Dhaka

+06:00 Sri Lanka Standard Time Columbo

+06:00 N. Central Asia Standard 
Time Almaty, Novosibirsk

+06:30 Myanmar Standard Time Rangoon

+07:00 SE Asia Standard Time Bangkok, Hanoi, Jakarta

+07:00 North Asia Standard Time Krasnoyarsk
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+08:00 China Standard Time Beijing, Chongqing, Hong 
Kong, Urumqi

+08:00 W. Australia Standard Time Perth

+08:00 Singapore Standard Time Singapore

+08:00 Taipei Standard Time Taipei

+08:00 North Asia East Standard 
Time Irkutsk, Ulaan Bataar

+09:00 Tokyo Standard Time Osako, Sapporo, Tokyo

+09:00 Korea Standard Time Seoul

+09:00 Yakutsk Standard Time Yakutsk

+09:30 AUS Central Standard Time Darwin

+09:30 Cen. Australia Standard Time Adelaide

+10:00 AUS Eastern Standard Time Canberra, Melbourne, Sydney

+10:00 E. Australia Standard Time Brisbane

+10:00 West Pacific Standard Time Guam, Port Moresby

+10:00 Tasmania Standard Time Hobart

+10:00 Vladivostok Standard Time Vladivostok

+11:00 Central Pacific Standard 
Time

Magadan, Solomon Is, New 
Caledonia

+12:00 Fiji Standard Time Fiji, Kamchatka, Marshall Is

+12:00 New Zealand Standard Time Auckland, Wellington

+13:00 Tonga Standard Time Nuku'alofa
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Windows NT 4.0 Time Zone Selection Chart  

The following is a list of time zones that are supported by ProblemTracker when installed on a Windows NT 4.0 
system. 

Time Zone 
Offset (in 
Hours)

Time Zone
System Time Zone (as 
displayed in Date/Time 
Settings)

-12:00 Dateline Standard Time Eniwetok, Kwajalein

-11:00 Samoa Standard Time Midway Is, Samoa

-10:00 Hawaiian Standard Time Hawaii

-10:00 Alaskan Standard Time Alaska

-08:00 Pacific Standard Time Pacific Time (US & Canada); 
Tijuana

-07:00 Mountain Standard Time Mountain Time (US & 
Canada)

-07:00 Mountain Standard Time 
[Arizona] Arizona

-06:00 Central Standard Time Central Time (US & Canada)

-06:00 Mexico Standard Time Mexico City, Tegucigalpa

-06:00 Canada Central Standard 
Time Saskatchewan

-05:00 Eastern Standard Time Eastern Time (US & Canada)

-05:00 Eastern Standard Time 
[Indiana (East)] Indiana (East)

-05:00 SA Pacific Standard Time Bogota, Lima, Quito

-04:00 Atlantic Standard Time Atlantic Time (Canada)

-04:00 SA Western Standard Time Caracas, La Paz
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-03:30 Newfoundland Standard 
Time Newfoundland

-03:00 SA Eastern Standard Time Buenos Aires, Georgetown

-03:00 E. South America Standard 
Time Brasilia

-02:00 Mid-Atlantic Standard Time Mid-Atlantic

-01:00 Azores Standard Time Azores

00:00 Universal Coordinated Time Casablanca, Monrovia

00:00 Greenwich Mean Time
Greenwich Mean Time: 
Dublin, Edinburgh, Lisbon, 
London

+01:00 Romance Standard Time Amsterdam, CopenHagen, 
Madrid, Paris, Vilnius

+01:00 Central European Standard 
Time

Belgrade, Sarajevo, Skopje, 
Sofija, Zagreb

+01:00 Central Europe Standard 
Time

Bratislava, Budapest, 
Ljubljana, Prague, Warsaw

+01:00 W. Europe Standard Time Brussels, Berlin, Bern, Rome, 
Stockholm, Vienna

+02:00 Egypt Standard Time Cairo

+02:00 South Africa Standard Time Harare, Pretoria

+02:00 Israel Standard Time Israel

+02:00 E. Europe Standard Time Bucharest

+02:00 FLE Standard Time Helsinki, Riga, Tallinn

+02:00 GTB Standard Time Athens, Istanbul, Minsk

+03:00 Arab Standard Time Kuwait, Riyadh

+03:00 E. Africa Standard Time Nairobi

+03:00 Russian Standard Time Moscow, St. Petersburg, 
Volgograd
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+03:30 Iran Standard Time Tehran

+04:00 Arabian Standard Time Abu Dhabi, Muscat

+04:00 Caucasus Standard Time Baku, Tbilisi

+04:00 Afghanistan Standard Time Kabul

+05:00 West Asia Standard Time Islamabad, Karachi, Tashkent

+05:00 Ekaterinburg Standard Time Ekaterinburg

+05:30 India Standard Time Bombay, Calcutta, Madras, 
New Delhi

+06:00 Central Asia Standard Time Almaty, Dhaka

+06:00 Sri Lanka Standard Time Columbo

+07:00 SE Asia Standard Time Bangkok, Hanoi, Jakarta

+08:00 China Standard Time Beijing, Chongqing, Hong 
Kong, Urumqi

+08:00 W. Australia Standard Time Perth

+08:00 Singapore Standard Time Singapore

+08:00 Taipei Standard Time Taipei

+09:00 Tokyo Standard Time Osako, Sapporo, Tokyo

+09:00 Korea Standard Time Seoul

+09:00 Yakutsk Standard Time Yakutsk

+09:30 AUS Central Standard Time Darwin

+09:30 Cen. Australia Standard Time Adelaide

+10:00 AUS Eastern Standard Time Canberra, Melbourne, Sydney

+10:00 E. Australia Standard Time Brisbane

+10:00 West Pacific Standard Time Guam, Port Moresby

+10:00 Tasmania Standard Time Hobart

+10:00 Vladivostok Standard Time Vladivostok
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+11:00 Central Pacific Standard 
Time

Magadan, Solomon Is, New 
Caledonia

+12:00 Fiji Standard Time Fiji, Kamchatka, Marshall Is

+12:00 New Zealand Standard Time Auckland, Wellington
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Frequently Asked Questions  

Our Frequently Asked Questions (FAQ) section is updated quite often. For the latest information, available 24 
hours a day, 7 days a week, please browse to the Frequently Asked Questions in the ProblemTracker Support 
section of our web site. It has answers to many questions that are asked by our customers. It is likely that you 
will find the answer to your question or resolution (or workaround) to a problem in the FAQ. 
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Contacting NetResults  

If you are unable to resolve a problem after searching the ProblemTracker Frequently Asked Questions section 
of our web site, and you are evaluating the product or have a current support agreement with NetResults, 
please contact us via email. Standard support is available via email on business days (Monday through Friday, 
excluding holidays). You should receive a response within one business day. Additional support options (e.g. 
phone support, extended hours) may be purchased from NetResults. Phone support is not included with the 
product, it must be purchased separately. 

For the appropriate support email address, standard support hours, and a list of information to send us for 
fastest resolution to your problem, please click here. If for some reason you are unable to reach our site via the 
web, please send your support email to 

pt_support@NetResultsCorp.com   or   pt_support@n2r6.com 

In your email please be sure to include the following information (emails with this information are generally 
given priority over those without): 

1.  Version of ProblemTracker you are using (e.g. 5.5, 5.0, 4.0). 
2.  Web Server software being used (e.g. IIS 6, IIS 5, IIS 4). 
3.  Database being using (e.g. MS Access, MS SQL Server 7.0, Oracle 8i/9i). 
4.  Operating System of the server on which ProblemTracker is installed (e.g. Windows NT 4.0 

Workstation/Server, Windows 2000 Server). 
5.  Web Browser software being used (e.g. IE 5/6, Netscape 6/7). 
6.  The full text of any error message which is displayed. In many cases if you get a generic database 

error message, you can scroll further down on the page to find more detailed error information. 
7.  The steps required to reproduce the problem. 
8.  Whether you are an evaluator or licensed user with support. 
9.  Attach the following files from your installation to your message:

❍     All files present in the installation log folder where you installed ProblemTracker. By default, the 
files can be found in C:\NetResultsPTLog. 

❍     If your problem is related to the Workgroup Management System, attach the file called 
ptadminlog.txt that can be found in the "pttmp" folder of your web server directory. By default, 
this file can be found at C:\Inetpub\wwwroot\ProblemTracker\pttmp\ptadminlog.txt. 

❍     If your problem is related to email notification messages, attach the file called emaillog.txt that 
can be found in the "pttmp" folder of your web server directory. By default, this file can be found 
at C:\Inetpub\wwwroot\ProblemTracker\pttmp\emaillog.txt. 

❍     For all other problems, attach all the files that can be found in the "pttmp" folder of your web 
server directory. By default, this directory can be found at 
C:\Inetpub\wwwroot\ProblemTracker\pttmp. 

Please be as specific as possible in your description of what is wrong. Including steps to reproduce the problem 
and the full text of all error messages is very helpful and can significantly reduce the amount of time it takes to 
resolve a problem. 
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